PSi

ATLAS Cloud® System
Requirements

Online Training and Assessment Services

Project

Customer

Author
Creation Date
Last Review Date

Electronic File Name

Information Category

ATLAS Cloud
ATLAS Cloud Admin

PSI

10 May 2016

10 October 2017

PSI_ATLAS Cloud System Requirements.docx

Unclassified Public



Revision History

Version
1.0
1.1
1.2
13
14
1.5
2.0
2.1
3.0
3.1
3.2
4.0
4.1
5.0
5.1
6.0
6.1
6.2
6.3
6.4
7.0

Date

10 May 2016

24 June 2016

13 October 2016
29 November 2016
5 December 2016
9 January 2017

9 January 2017

14 March 2017

14 March 2017

28 March 2017

11 April 2017

11 April 2017

28 April 2017

5 May 2017

12 June 2017

12 June 2017

15 August 2017

1 September 2017
22 September 2017
9 October 2017
10 October 2017

Approval Section

Name Position
Tom Masters Head of
Delivery

ATLAS Cloud System Requirements

Comments
Document created
Document updated
Document updated
Document updated
Document updated
Document updated
Document approved
Document updated
Document approved
Document updated
Document updated
Document approved
Document updated
Document approved
Document updated
Document approved
Document updated
Document updated
Document updated
Document updated

Document approved

Signature

Service

Date
10 October 2017

Unclassified Public

2



Contents
Revision History 2
Approval Section 2
Contents 3
Introduction to ATLAS Cloud® Software Requirements 6
ATLAS Cloud® Software Requirements (All users) 7
SUPPOIrtEd OPErating SYSTEMS ...ttt sttt ssssssssssssssss st s st ssssssssssnses 7
SUPPOIrtEd SCreEN RESOIULION ...ttt sttt sttt sttt ss st ss s ssnsen 7
SUPPOMEA BIrOWSETS......oeeieeeeeeireeiesiesessstssstsessssssss st ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnses 7
POPUP BIOCKET ..ottt bbb bbb bbb bbb 8
INEINET CONNECLION oottt ettt ettt 8
FIFEWAIL SEHHINGS ..veeveeereerieeeiies ettt st st ss s sss s sttt ss bbb st e 8
TECNICIAN CHECKIIST....ouvieerceereeieeeiecie ettt esi st sniesens 8
Other Settings — IN-application tESTS ONIY ... ssaneens 8
Appendix A: In-application Testing — Additional requirements 9
System Requirements....
Operating System.......
In-application SCreen RESOIULION ...ttt sttt ssssssssseens 9
INET FIramEWOTK oottt ettt sttt e 9
SUPPOIrted MiICrOSOft OffiCE....umiiireeee sttt sssssseses 9
Unsupported MicroSoft OffiCe.......irrnsssinessess s 10
MiICroSOft OFffiCE 2007 ..ottt sttt st sttt sssssnssens 10
Microsoft Office 2003 ...ttt sttt st st sssssnssens 10
Other OffiCe VEISIONS ...t ssise et ssssessssss s sssssse s ssssesssssesessns 10
Additional Microsoft COMPONENTS ... ssssssssssssssssssssssssssssssnnss 11
SEIVICE PACKS oot esssssssssssse st sisesseseeseseesessessnseses 11
IN-aPPIICAtION PIUGIN oottt s s 11
EXEENSIONS ..ottt it et et 11
ACCESS 1O WOTK FIlES ..ottt sttt ssstsssss sttt ss st ss st s ssnses 11
Access t0 the WINAOWS REGISEIY ...t eeseesssessssessssssnees 12
Printer Configuration (Required for all versions of Microsoft Office)........ccccouvuenne 12
WVINAOWS 8/T0 et ee e eeeeese s eseae e s s s e aee s s s eesasasasesaseaeasasasesaeeens 12
WINAOWS 7ottt bbb bbb bbb bbb e 12
Microsoft Office Language VErSIONS .......oremreenneeereeeereeesseeessseesssessssessssssssessssssssssnees

Windows Regional and Language Settings
Anti-Virus

Support

ATLAS Cloud System Requirements Unclassified Public 3



Appendix B: In-application Testing - Microsoft Edge 14
Change the Microsoft Edge default Drowser ..., 14
Appendix C: In-application Testing - Other Microsoft Office Application Settings..16
MICTOSOTt OFfICE 20T6.....oomeeeereeeeceeeeeiseeeessseeess st sssseess st st ss st ssssesess e 16
Interface Settings for Microsoft Word 20716 ...........crinnernnernneisnessseesssessensseenns 16
User Interface Settings for Microsoft EXCel 20716 ........coooivrrrvrnernnernneinneinnsiessiesseenns 16
Interface Settings for Microsoft Word and EXCel 2016 .......cooovvvvreeerevnrrernreernnsirnsienenns 17
Macro Security Settings for MS Word, Excel and PowerPoint 2016..........ccoo.couvvunne 17
Macro Security Settings for Microsoft ACCess 2016........cooorermrnrrernneenneeenneeesseeesneeennens 18
Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
20716 (OPLIONAI..ueiieririerie ettt sttt ss st st ss st sttt st st ss st nnsnes 18
MICTOSOTt OFfiCE 20713 ..ottt ettt sttt 19
Interface Settings for Microsoft Word 20713 .........occnencnecneeeseeeseeeseeesseeennens 19
User Interface Settings for Microsoft EXcel 20713 ... 19
Interface Settings for Microsoft Word and Excel 20713 ... 20
Macro Security Settings for MS Word, Excel and PowerPoint 2013......c..cccoovoveeenees 20
Macro Security Settings for Microsoft ACCess 20713........crrrronneecnneneresnssessesesnesennnns 21
Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
20713 (OPLIONAI ettt sttt ss st st ss st sttt st st st snsnns 21
MIiCrOSOTt OFfiCE 200 ..ottt ettt ettt 22
Interface Settings for Microsoft Word 20710 .........cconeeeneeeneeeneeeneeeneeeseeeseeessenennens 22
Interface Settings for Microsoft EXCel 20T0.........ouvrereeeneeeneeereceneciseeeneeeseeeseeessenenens 22
Interface Settings for Microsoft Word and EXCel 2010 ... 23
Display Any Hidden Workbooks in EXCel 2070 .......coovrrurmeuneeeeneeeseeeeeeseceseeeseeesseeennees 23
Macro Security Settings for Microsoft Word, Excel, PowerPoint 2010........cccccconeeee. 23
Macro Security Settings for Microsoft ACCess 20710........coumrnmrronnrrcnnisnsrisnsrenssessssennens 24
Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
20710 (OPLIONAIY ittt sttt b s sss st st sssss sttt sss st nsssnsssnns 24
Appendix D: Unsupported Operating Systems and Browsers 25
Unsupported Operating SYSTEMS ... isseesssseesseesse s ssssssssssssesssssssnes 25
MiCrOSOTt WINAOWS XP ..ottt essss s e ssssssssss st ssssssnees 25
IMICTOSOTE VISTA c.oouiieirceimciiieceieceiee ittt esssss sttt st sns s 25
UNSUPPOIEEA BrOWSELS ....cooereeeiereieeaeseeeseseessssesssssssssssss s s s ssss s ssss s sssesssssasssasssasssssssasssans 25
SAFAIT TOF PC ittt sttt bbbt 25

Old Versions of GOOGIe ChrOME........irververiessins s sssssssssssssssssssessssessssssssnns 25

Old VErsioNnS Of FIFEOX c..uiuuureeeeeieceineciineeiisseeessseeeissee it ssssesesssesesssssesssss s ssssssessnaes 25
Appendix E: Technicians Checklist 26
Checklist fOr All USEIS — Part T ... eesseeeeeesseesss st ssses s sssssssssssssssssssssssssanees 27
SUPP O ettt st s e e e e e 27
Supplementary Checks for In-application Testing only — Part 2........cccccooeonnneennrennrenenes 28
In-application TESTING SUPPOIT ...ttt ssss s ss s 29

ATLAS Cloud System Requirements Unclassified Public



TSt RUNTIME EITOIS ...cccoieiricrieniciecniecsiecsesessanesssnesssessse i i sesessasessasessasessanes 29

Appendix F: Plugin Guide (In-application tests only) 30
Installing the PSI In-application Plugin prior t0 TeStiNg.....ccccounrenrenrinerenseennensrnseenesenenenenes 31
Installing the Google Chrome Extension prior tO teSting ........cc.cceeereenreeneenrernrinrinnenn. 35
Installing the Mozilla Firefox Extension prior t0 teSting.....c..coewvreverevnriernneernnsiserienenns 38
Installing the PSI In-application Plugin at the time of Testing ....c...cccovovevvcrrrvcnnivcnnrrnnrinnnnns 41
Installing the Google Chrome Extension at the time of testing.........ccoccouvvvervrnrres 46
Installing the Mozilla Firefox Extension at the time of testing ........cccoeceevvrerirnrrennnns 49

ATLAS Cloud System Requirements Unclassified Public

5



Introduction to ATLAS Cloud® Software Requirements

This document has been provided to help ensure the correct software requirements are
being used for ATLAS Cloud. The main body of the document covers the requirements for
all users. The specific requirements for in-application users are included in the
appendices, which are referred to throughout the document.
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ATLAS Cloud® Software Requirements (All users)

Supported Operating Systems

e  Microsoft Windows 7/8/10 (32 and 64-bit)
e Apple Mac OS (and Mac OS X) 10.5.x, 10.6.x *

* Note that whilst item bank tests are supported on Apple Mac operating systems, there is no support
for in-application tests. For more information on PSI In-application configuration, see Appendix A or
contact PSI support at intl-support@psionline.com

Please refer to Appendix D for unsupported operating systems

Supported Screen Resolution

The recommended screen resolution is:

¢ Non-test users - at least 1024x768 pixels with 16k colours
e All test users - 1920x1080 pixels with 16k colours*

however, the minimum screen resolution required will be dependent on the test content being
delivered and in many cases a smaller screen resolution may be used. For further information see

Appendix A

@ *Using this resolution will ensure that the on-screen area is large enough to support all types of test;

Supported Browsers

Please see below a list of supported web browsers (32 and 64-bit):
e Internet Explorer: Version 11 as noted below

In line with Microsoft's policy on browser support, only the following versions of
Internet Explorer will receive support:

Windows Desktop OS Internet Explorer Version
Windows 7 SP1 Internet Explorer 11
Windows 8.1 Update Internet Explorer 11
Windows 10 Internet Explorer 11

e Firefox Latest Version

e Google Chrome Latest Version*

*The latest version of Chrome must be used for the item banking audio capture (speaking) test
question to work

We recommend that the default web browser is changed from Microsoft Edge to a web browser that
is supported by ATLAS Cloud®. For in-application testing, it is essential that the web browser is
changed from Microsoft Edge. Please see Appendix B for the steps required.

Please refer to Appendix D for unsupported browsers

ATLAS Cloud System Requirements Unclassified Public 7
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Pop-up Blocker

If you use a pop-up blocker, pop-up windows must be allowed for *.psionline.com.

@ Please note that if you use Windows 8 or Windows 10, Internet Explorer must be running in
desktop mode to run a test

Internet Connection

Download speed requirements are dependent on the number of concurrent users and
usage patterns. As a rough guide, we recommend at least 512 Kbit/s per user, but no less
than 10 Mbit/s of total available capacity *

For test users, the largest files are typically downloaded at the start of a test, however this may vary
with test type. Speed requirements may be increased if the test includes media objects or large
work files.

Firewall Settings

ATLAS Cloud uses http and https. Any firewall or proxy must be configured to allow:

e HTTP access (destination TCP port 80, URLs begin with http://)
e HTTPS access (destination TCP port 443, URLs begin with https://)
e DNS lookups (TCP/UDP port 53, check your DNS server address)

Any firewall must also allow the downloading of .bin (Binary data) and .jar (Java Archive)
files.

Technician Checklist

There is a one-page checklist on Appendix E Part 1 that can be used as an aide memoire
for Technicians. This should be used in conjunction with the rest of this document, not as
a standalone reference.

Other Settings — In-application tests only

There are other settings that are required for in-application tests only. These are:

1. Additional Requirements - for all additional system requirements for in-
application tests only including plugin and extension, printer configuration,
windows and language settings. For details of the full requirements, please refer
to Appendix A and Appendix F

2. Change Microsoft Edge Browser — for the steps required to change the default
browser from Microsoft Edge, please refer to Appendix B

3. Other Office Settings — for the settings required for each office version, please
refer to Appendix C

4. Technician checklist - an aide memoire for any IT Technicians that are setting up
machines prior to testing a Checklist has been provided in Appendix E Part 2.
This is in addition to the Part 1 checklist required for all users

ATLAS Cloud System Requirements Unclassified Public
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Appendix A: In-application Testing — Additional requirements

System Requirements

The following system requirements are for in-application testing only.
Operating System

Only Microsoft Windows operating systems can run an in-application test.

Microsoft Windows 7/8/10
In-application Screen Resolution

Using a resolution lower than 1920x1080 for in-application tests may result in a need to
maximize the application in order to answer particular questions. Use of screen
resolutions as low as 1024x768 is supported and will not prevent the test from
functioning as expected; however, the candidate experience will not be as intended.

.NET Framework

.NET Framework version 3.x is required. The .NET Framework Redistributable Package can
be downloaded from: http://www.microsoft.com/en-gb/download/details.aspx?id=3005

A download link is also provided on the System Requirements Check page.

Supported Microsoft Office

In-application tests are available for the following Microsoft Office (32 and 64-bit)
components:

e Microsoft Word

e Microsoft Excel

e Microsoft PowerPoint

e Microsoft Access (Professional and Professional Plus only)
e Microsoft Project 2010/2013

ATLAS Cloud System Requirements Unclassified Public 9
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In-application tests are supported with the following editions of Microsoft Office:

Microsoft Office 2016 Home and Student @); Home and Business (); Standard )
Professional; Professional Plus;
Office 365 Home @); Office 365 Personal @)

Microsoft Office 2013 Home and Student @); Home and Business (); Standard ()
Professional; Professional Plus;

Office 365 Home @); Office 365 Personal @)

Microsoft Office 2010 Home and Student 2; Home and Business (2); Standard );
Professional; Professional Plus

(1) PowerPoint and Access modules are not available.
@ Access modules not available.

@ Office 365 is only supported with a “Full, local installation”. For more information,
please click here.

Unsupported Microsoft Office

Please note that we no longer offer support for the following versions of Microsoft Office
and Operating Systems:
Microsoft Office 2007

Microsoft Office 2007 ceased to be supported by Microsoft as of 10 October 2017 and
therefore will cease to be supported as an operating environment for ATLAS Cloud.

Microsoft Office 2003

Microsoft Office 2003 ceased to be supported by Microsoft as of 8 April 2014 and
therefore will cease to be supported as an operating environment for ATLAS Cloud.

Other Office Versions

Please note that Office Starter Edition, Office online and Trial editions of Microsoft Office
are not supported.

ATLAS Cloud System Requirements Unclassified Public 10
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Additional Microsoft Components
Service Packs
The latest Service Packs and updates for Microsoft Office must be installed. The most

recent available Service Packs for Microsoft Office (English language versions) can be
found here:

e 2016: We recommend that the latest updates are installed, but there is no Service
Pack requirement

e 2013 Service Pack 1:
https://support.microsoft.com/en-us/kb/2817430

e 2010 Service Pack 2:
https://support.microsoft.com/en-us/kb/2687455

In-application Plugin
In-application testing requires the PSI In-application Plugin.

@ To install the PSI In-application Plugin, please refer to the Appendix F

Extensions

The Plugin installation guide also covers the extensions required for Chrome and Firefox
users as well as the requirement for the latest plugin.

Internet Explorer users only require the latest plugin installed.
Access to Work Files

Work files can be saved either to a virtual drive mapped to the temporary folder (default)
or to the Documents folder.

When using a mapped drive (default, recommended):

e The virtual drive will be mapped to the last available drive letter on your local
system (usually Z:).

e A Windows administrator can hide some drive letters by applying a Windows
Group Policy (Hide these specified drives in My Computer). If the virtual drive is
mapped to a hidden drive letter, the virtual drive will not be seen and will thus
not function properly. Our recommendation is to use the default setting, which is
to not hide any drives. See http://support.microsoft.com/kb/231289 for details.

When not using a mapped drive:

e The wuser must be allowed to save files to the Documents folder
(the My Documents in older versions of Windows).

e The Documents folder must not be shared between multiple users taking ATLAS
Cloud In-App tests at the same time.

ATLAS Cloud System Requirements Unclassified Public 11
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Access to the Windows Registry
If Windows Registry access has been restricted for any reason, users must still be allowed
normal read and write access to the Windows Registry areas where the users’ settings are

stored (HKEY_CURRENT_USER). This is the default setting in Microsoft Windows for a
non-administrator user.

Printer Configuration (Required for all versions of Microsoft Office)

ECDL/ICDL tests require that you have a functional printer and printer driver installed.
Please perform the following steps on all computers used for testing.

Windows 8/10

1. Click the Start button, or press the key

2. Type Devices and click Devices & Printers

3. Underneath the Printers section, ensure the green tick is marking a functional
printer (you can test whether a printer is functional by using right click >
Properties > Print test page)

4. If the required printer is on the list, but does not have the green tick covering it,
right click the printer and click Set as default printer

5. If the printer does not reside within the list at all, then please follow the
manufacturer’s instructions for installation

Windows 7

1. Click the Start button

2. Click Devices and Printers

3. Underneath the Printers and faxes section, ensure the green tick is marking a
functional printer (you can test whether a printer is functional by using right click
> Properties > Print test page)

4. If the required printer is on the list, but does not have the green tick covering it,
right click the printer and click Set as default printer

5. If the required printer does not reside within the list at all, then please follow the
manufacturer’s instructions for installation

Microsoft Office Language Versions

ECDL/ICDL Advanced tests are designed to be used with specific Microsoft Office user
interface languages. The test language must match the Microsoft Office language.

Test Language Suffix Designed for the following MS Office Language
Eng English (United Kingdom)

US Eng English (United States)

CAEng English (Canada)

CH-Deu German (Switzerland)

CH-Fra French (Switzerland)

Ned Dutch (Netherlands)

Rom English (United States)

ATLAS Cloud System Requirements Unclassified Public 12



Windows Regional and Language Settings

ECDL/ICDL tests rely on certain formats in Windows Regional and Language Settings. The
test language must match the formats of the language and country for which the test is
designed. The formats are: Date format, Number format and Measurement system.

Test Designed for the Date Number Measurement
Language following Windows Format Format System
Suffix Regional and Language  (Short)

Settings
Eng/UK Eng English (United Kingdom) 23/06/2011 123,456,789.00 Metric
US Eng English (United States) 6/23/2011 123,456,789.00 u.S.
CAEng English (Canada) 23/06/2011 123,456,789.00 Metric
CH-Deu German (Switzerland) 23.06.2011 123,456,789.00 Metric
CH-Fra French (Switzerland) 23.06.2011 123,456,789.00 Metric
Ned Dutch (Netherlands) 23-6-2011 123,456,789.00 Metric
Rom English (United States) 6/23/2011 123,456,789.00 Metric
Anti-Virus

The ECDL Foundation has provided and virus checked the Microsoft Office work files used
in the PSI ECDL/ICDL tests. However, test centres are advised to use updated anti-virus
software on candidate machines.

Support

If you have any questions or require support, please contact your regional provider.

ATLAS Cloud System Requirements Unclassified Public 13



Appendix B: In-application Testing - Microsoft Edge

Change the Microsoft Edge default browser

The Microsoft Edge web browser provided with some Windows operating systems is not
compatible with the PSI In-application Plugin. If you are using Windows 10 then please
use Internet Explorer 11, which comes pre-installed.

To change the default web browser from Microsoft Edge to Microsoft Internet Explorer,
follow the instructions below:

1. Within the search field type: default browser and press Enter
2. Then click Choose a default web browser from the top of the search results

@ Choose a default web browser
System settings

Settings

% Default app settings

Web

2 default browser

£ default browser change

O default browser internet explorer
£ default browser google

2 default browser setting

2 default browser choice

£ default browser windows 10

2 default browser edge

58 My stuff £ Web

H default browses

3. Press Default apps

ATLAS Cloud System Requirements Unclassified Public 14



4. Then under the Web browser section press Microsoft Edge

02 sysTEM
Display

Notifications & actions
Apps & features
Multitasking

Tablet mode

Power & sleep
Storage

Offline maps

Default apps.

About

Find a setting

Maps

o-

Music player

Groove Music

Photo viewer

E Photos

Video player

E Film & TV

Web browser

|‘ E Micresoft Edge

5. Press Internet Explorer

& settings
€32 SYSTEM
Display

Notifications & actions

Apps & features

Multitasking

Tablet mode

Power & sleep

Storage

Offline maps

Default apps

About

Find a setting

Maps

Maps

Music player

Choose an app
Photo Default Host Application

EH E Internet Explorer

Video E Microsoft Edge
E Look for an app in the Store

Web t

E Microsoft Edge

6. Internet Explorer is now the default web browser within Windows 10

& settings
3% SYSTEM
Display

Notifications & actions

Apps & features

Multitasking

Tablet mode

Power & sleep

Storage

Offline maps

Default apps

About

Find a setting

Maps
Music player

Groove Music

Photo viewer

E Photos

Video player

E Film & TV

Web browser

E Internet Explorer

Please note that this procedure can also be used to change the default web
browser to an alternative browser, such as Firefox or Chrome.
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Appendix C: In-application Testing - Other Microsoft Office
Application Settings

The following settings in Microsoft Office applications should be applied by the test
centre prior to an ECDL/ICDL test.

Microsoft Office 2016

Interface Settings for Microsoft Word 2016

The Status Bar must display Sections.

Customize Status Bar

Formatted Page Murmber 1
I + Section 1 I
v Page Mumber Page 1of1
Wertical Page Position 2.5cm
Line Murmber 1
Lolumn 1
v Word Count Ouweords

User Interface Settings for Microsoft Excel 2016

The Compare and Merge Workbooks icon must be available on the Quick Access
toolbar for use during a test.

Excel Ophions v =
..... I Py
! i-'H Customime the Quick Acoess Taolbar,
Choose commands froer Custoenare Qusck Sccess Toolbar

rodting Adl Cammands zl For 8l docuements (default) EI
S

_— = Combine & - o S
Language ;': l.r ing m'. . L 2 nda "
Aabanced .:_-) Redo "
Customise Ribibar L_tempy: anohorgs onbooh, J
Quick Bccess Toolbar s

Sdd 3 -

<< Bemove

Custoamazations: Rgset =

ImpatyExpart =

=l Cancal
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Interface Settings for Microsoft Word and Excel 2016

The Developer tab must be turned on.

Ward Ogtians
Garserl
Diaplay
Proofing
Sarve
Language
Adwnced
| Customize Ribbon
Quick Accers Toolbar
Adds[ms

Trast Certer

% Custormeze the Ribbon and keyboard shortouts.

Choose commands from: 0

Popular Commands

Accept Revision
Add Table

Aligr Left

Bullets

Center

Chanege List Lewel

Copy
Cut

I EEs

Delate
Dirarer Table
Dirrer Wertical Text Box
Ernail

Find

P F b Waindies Whidth

Fank

Font Color

Fonk Settngs

Font Sze

Faoknate

Farrmat Painter

Girceae Fant

Hyperdink...

Inzert Comment

Ensert Page Section Breaks
Bnaert Pucture
Braert Teak B

EIRY S<& &l

>» O[F

B> &

Keyboard shortouts;

Defiree Mew Miamber Foamat..

Customize...

[=]

I=

Customize the Rigbor: 0
bdain Tabs

Mo Tabs

= ¥ Home
E Chipbosrd
E Font
# Paragraph
B Indes
H Editing

& [ [nzert

& [ Design

B [J Layout

& [ Reference:

& [#] Mailings

P Do

& ] Add-lns

& ¥ Blog Post

& [ Irzert (Blog Posth

= :Jj':ll..'.llnlr\-g

® ] Background Remaval

Mewr Tab

Berwr Group

Rararns,.,

| Emport/Export =

Macro Security Settings for MS Word, Excel and PowerPoint 2016

The Trust access to the VBA project object model box must be checked.

Trust Center

Truited Publithers
Trusted Locations
Trwsted Documents
Trwsted Add-in Catalogs
Bddsing

Bucteeek Jatting

Macn Settings
Protected View
Message Bar

File Black Sethngs

Provacy Options

ATLAS Cloud System Requirements

Mairo Seltinig

Disable a)l macros without notification

& [Disable all mscros with notificstion

Disable all macros eocept digitally signed macros

Enabde all macros {(not recommended; potentially dangerous code can ran)

Developer Macro Settings

[ [ Trust sccess to the VBA project object model ]

Ok Cancel
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Macro Security Settings for Microsoft Access 2016

1. Go to File menu > Options > Trust Center
2. Click Macro Settings
3. Check Enable all macros

Trud® Cenler

Marro Settings

Mucrs Satting:

age Bar

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
2016 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft
Word, Excel, PowerPoint and Access, take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center
Settings

2. Click Message Bar

3. Check Never show information about blocked content

| Trust Center

Message Bar Settings for all Office Applications

I¥] Show Policy Tip in the Message Bar. Turmang £k

@ Important: We advise that you do not change security settings in the Trust
Center, as there can be consequences of loss of data, data theft, or security

compromises on your computer or network.
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Microsoft Office 2013

Interface Settings for Microsoft Word 2013

The Status Bar must display Sections.

Customize Status Bar

|~

L

s

User Interface Settings for Microsoft Excel 2013

Formatted Page Murmber 1
Section 1 I
Page Murnber Page 10of1
Wertical Page Position 2.5cm
Line Murmber 1
Lolurmn 1
Wrord Count Oweords

psi

The Compare and Merge Workbooks icon must be available on the Quick Access
toolbar for use during a test.

Excel Options

Save

General
Formulas

Procfing

Language
Advanced

Customize Ribbon

N<EERSF -

Quick Access Toolbar
Add-Ins

Trust Center

Iy

& Customize the Quick Access Toolbar.

Choose commands from:(i)

All Commands

Close Ink Tools
Close Print Preview

K]

Close Window
Code

=  Collapse Entire Field
Colon

Color

Color Saturation
Color Scales

Color Tone

v v v v w

Column

Column Headers
7 Column Width...

Columns I
COM Add-Ins...

Combine Characters

Combo Box (ActiveX Control)

Combo Box (Form Contral)

Combo Drop-Down - Edit (Form Contr..
Combo List - Edit (Form Control)
Comma

Comma Style

Command Button (ActiveX Control)
Comments

ko~ Dl e B

Compare and Merge Workbooks...
[k Compatibility »

D Show Quick Access Toolbar below the Ribbon

Customize Quick Access Toalbar(i)

For all documents (default)

Save
Undo
Badl

ORSsE

Compare and Merge Workbooks...

Wodify...

Customizations: -i‘
Import/Export ¥ |1
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Interface Settings for Microsoft Word and Excel 2013

The Developer tab must be turned on.

Word Options

G | . .
Ener @E Custornize the Ribbon and keyboard shorteuts,
Display
Lhoose commands from: (0 Custarnize the Ribbaon: (0
Proofing
Popular Commands v Main Tabs v
Save
Language Acceptand Move to Next ~ [ Page Layout n
Align Left References
Advanced Breaks 4
Bullets L4
Customize Ribbon Center
. = Change List Level 4
Quick Access Toolbar . -
EZ Copy
Add-Ins J6 Cut =
Define Mew Murnber Farmat..,
Trust Center % Delete & [oF lnzavk iBlan Dot hd
Diraw Table
MNew Tab Mew G R
[E] Draw ertical Text Box v e e Ename
il rooon Custornizations: Reset ~ i
Keyboard shorcuts: | Customize.., Import/Expart ¥ |0
< >

Macro Security Settings for MS Word, Excel and PowerPoint 2013

The Trust access to the VBA project object model box must be checked.

+3= =
FILE HOME  IMSERT  DESIGN  PAGELAYOUT  REFERENCES  MAILINGS  REVIEW  VIEW  DEVELOPER
vj D 2 Record Macrn & [z Ad fa (= EE DL Design Mode I'E D [‘A
L e pause Recarding i + B & Praperties . i+
Visual Macros - Add-lns COM ¥MLMapping  Block  Restrict  Document Document
Basic Add-Ins - Group Pane futhors - Editing | Template  Panel
Cade Add-Ins Cantrals Mapping Protect Templates
L Trust Center ? 3
Trusted Publishers TEmr—
Trusted Locations
N e Disable all racros withaut notification
ruste OCUrmEnts
Disable all macras with netification
Trusted App Catalogs O Disable all macras except digitally signed macros
Bddeing ) Enable all macros (nat recommended; patentially dangerous cade can run)
ActiveX Settings Developer Macro Settings
~ Macro Settings
Trust access to the WA praject abject model |
Protectsd Wiss
Message Bar
M File Block Settings

ATLAS Cloud System Requirements

Unclassified Public 20



psi

Macro Security Settings for Microsoft Access 2013

1. Go to File menu > Options > Trust Center
2. Click Macro Settings
3. Check Enable all macros

Trust Center > IEE

Trusted Publishers
Macro Settings
Trusted Locations
(O) Disable all macros without notification

Trusted Documents . . o
(_) Disable all macros with notification

Add-ins () Disable all macros except digitally signed macros
ActiveX Settings (® Enable all macros (not recommended; potentially dangerous code can run)
Macro Settings

Message Bar

Privacy Options

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
2013 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft
Word, Excel, PowerPoint and Access, take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center
Settings

2. Click Message Bar

3. Check Never show information about blocked content

| Trust Center ¥ x
Trusted Pubhghen
Message Bar Settings for all Office Applications
Trusted Locations
Shawing the Message Bar
rusted Decuments Sherw the Mesiage Bar in 8 applicstions when sctive content, such as ActroeXl cortrals and macnos, has
. . . been blocked
rugtied Add-in Catalogs - - -
I‘ Mever show mformation sbout blocked content
digdd-ang . . =
. Palicy Ti
ActiveX Settings =y e
Bacro Settings [# Show Policy Tip in the bessage Bar. Tuming this off will disable all Poicy Tigs wnless your organization requires
) it
|| Protected View
Meszage Bar

File Blodik Settings

Privacy Options

@ Important: We advise that you do not change security settings in the Trust
Center, as there can be consequences of loss of data, data theft, or security

compromises on your computer or network.
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Microsoft Office 2010

Interface Settings for Microsoft Word 2010

The Status Bar must display Sections.

Customize Status Bar
Formatted Page Mumber 8
v | Section 1
Page Mumber §of8
Vertical Page Pasition 20.5em
Line Mumber 26
Caolumn 1
y Word Count 1,068
MNumber of Authors Editing
Spelling and Grammar Check Errors
m Language

Interface Settings for Microsoft Excel 2010

psi

The Compare and Merge Workbooks icon must be available on the Quick Access
toolbar for use during a test.

General

Formulas
Proofing

Save

Language
Advanced
Customize Ribbon
Add-Ins

Trust Center

[
Customize the Quick Access Toolbar.

Choose commands from: (i)

All Commands

[=]

g Color

Color Saturation
Color Scales
e Color Tone
Column
Column Headers
1 Column Width...
Columns

COM Add-Ins...

[] show Quick Access Toolbar below the
Ribbon

Add > >

Customize Quick Access Toolbar: (i)

For all documents [default)

H Save

¥} Undo

Te—

<< Remove

Modify...

Customizations: i
Import/Export ~ |0

ATLAS Cloud System Requirements
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Interface Settings for Microsoft Word and Excel 2010

The Developer tab must be turned on.

General

Display

Proofing

Save

Language

Advanced

Quick Access Toolbar
Add-Ins

Trust Center

s
Customize the Ribbon and keyboard shortcuts.

Choose commands from: (i)
Popular Commands

Q Accept and Move to Next
= Align Left

Ereaks

Bullets

Center

Change List Level

Copy

Cut

Define Mew Mumber Format..,
Delete

Draw Table

Draw Vertical Text Box
E-mail

Find

ERELE =i/

Add =>

<< Remove

Customize the Ribbon: i)
Main Tabs

=1 [ nore
Clipboard
Font
Paragraph
Styles
Editing

[¥] Insert

Page Layout

References

Mailings

Review

View

Developer

Gl 24| ArddTne

Font [ Mew Tab ] [ﬂm Gmup] [ Rename... ]

Customizations: i
Import/Export [

A Ennt

Ceybora shorteuts

Display Any Hidden Workbooks in Excel 2010

Hidden workbooks must be displayed by choosing the Unhide command on the View
tab.

=W View Load Test Team

L

] =] split O vie
— &

L W S R = e = Hide 3} syncl
Zoom 100% Zoomto MNew Arrange Freede -

Selection | Window Al Panef- | Unhide| |4 Rese

Zoom Windao

Macro Security Settings for Microsoft Word, Excel, PowerPoint 2010

The Trust access to the VBA project object model box must be checked.

Page Layout References Mailings Review View

Aa Aa [5 B Design Mode E &5 Schema o]
ERLEE e . .

= =

Developer

‘ = B record Macro
= =

Trusted Publish
rusted Publishers Macro ings

Trusted Locations N
() Disable all macros without notification

Trusted Documents Disable all macros with notification

Add-ins Disable all macros except digitally signed macros

(7) Enable all macros [not recommended; potentially dangerous code can run)
ActiveX Settings

Macro Settings

Protected View

Developer Macro Settings

I Trust access to the VBA project object model I

PRl 200 0 19 QB

Message Bar
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Macro Security Settings for Microsoft Access 2010

Please go to File menu > Access Options > Trust Center > Trust Center Settings > Macro
Settings > Enable all macros. Failure to apply this setting will mean that not all Database
content is enabled; therefore, some questions cannot be completed.

Records Find il Qe Text Formatting
Access Optiohs [7Ile=]
General
@ Help keep your documents safe and your computer secure and healthy,
Current Database
Datashest Protecting your privacy
Ohject Designers Microsoft cares about your privacy, For more information about how Microsoft Access helps to protect your privacy,
| b ok ..
Praofing Trust Center (7|
Language -

Trusted Publishers
Macro Seltings

Client Setti
[ SRS Trusted Lacations

1 Disable all macros without notification
' Disable all macros with notification

Custamize Ribbon Truskad Documants

ulck Access Toolbar | E (@]
Q Add-ins Disable a_H macros except dlﬁltallg slﬁned Macros

. I-ﬂ- Enable all macros [not recommended; potentially dangerous code can run) I
Add-ins ActiveX Settings

| Trust Center | Macro Settings |

DEP Settings

[ cance

Message Bar Security Settings for Microsoft Word, Excel, PowerPoint, and Access
2010 (Optional)

To remove the blocked content message appearing on the message bar for Microsoft
Word, Excel, PowerPoint and Access you can take the following steps:

1. Go to New document > File menu > Options > Trust Center > Trust Center
Settings

2. Click Message Bar

3. Check Never show information about blocked content

| Trust Center ¥ =

Metsage Bar Settings for all Office Applications

1o Settin ge Bar. Turring this off will disat [ nless yo ]
il
| Meiiage Bar
File Bloci Settings

@ Important: We advise that you do not change security settings in the Trust
Center, as there can be consequences of loss of data, data theft, or security
compromises on your computer or network.

ATLAS Cloud System Requirements Unclassified Public 24



psi

Appendix D: Unsupported Operating Systems and Browsers

Unsupported Operating Systems

Please note that we no longer offer support for the following Operating Systems:
Microsoft Windows XP

Microsoft Windows XP ceased to be supported by Microsoft as of 8 April 2014 and
therefore is not supported as an operating environment for ATLAS Cloud.

Microsoft Vista

Microsoft Vista ceased to be supported by Microsoft as of 11 April 2017 and therefore is
not supported as an operating environment for ATLAS Cloud.

Unsupported Browsers

Any earlier web browser versions, other than those mentioned here, are not supported.

Safari for PC

We plan to announce official support for Safari in the near future, although this will not
include the use of in-application testing.

Old Versions of Google Chrome
We do not support versions of Google Chrome prior to version 45.
Old Versions of Firefox

We do not support versions of Firefox prior to version 53.
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Appendix E: Technicians Checklist

This checklist has been created to help Technicians to minimise any configuration and
incompatibility issues when running tests through ATLAS Cloud.

This document supplements the system requirements check accessible via the Check
System Requirements link on the ATLAS Cloud login page, as well the full system
requirements document.

There is a Part 1 for all users, and a Part 2 that is required by in-application users only.
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Checklist for All Users — Part 1

System Check

Operating system

Browser

Disabling of pop-
up blockers

Bandwidth

Firewall
configuration

MIME types

The following checks are required for all users of PSI ATLAS Cloud:

Requirements

One of the following:
Windows 7

Windows 8

Windows 10

(Mac users, see here)

One of the following:
Internet Explorer version 11
Google Chrome

Firefox

All pop-up blocking technologies must be
disabled for *.psionline.com

Download speeds of at least 512Kbit/s per
user are required with no less than 10
Mbit/s of total capacity

ATLAS Cloud uses:

HTTP (Port 80)

HTTPS (Port 443)

DNS Lookups (port 53 TCP/UDP)

.BIN files
JAR files

Support

Implications / Things to be considered v /x
If using Windows 10 for testing, you must use Internet Explorer

version 11 or the latest versions of Chrome and Firefox, as

Microsoft Edge (the default browser) is currently not supported

For information on how to change the default browser in Windows
10, please see Appendix B

Please note that if you use Windows 8 or Windows 10, Internet
Explorer must be running in desktop mode to run the test

See Checklist Supplement section - Part 2 below for more
information on requirements for in-application testing

The latest version of Chrome must be used for the item banking
audio capture (speaking) test question to work

See Checklist Supplement section - Part 2 below for more
information on requirements for in-application testing

Toolbars within browsers, e.g. the Google Toolbar, can contain
pop-up blockers

If adding exceptions to site lists, ensure that both the HTTP and

HTTPS variants of our URL are used

See Checklist Supplement section - Part 2 below for more
information on requirements for in-application testing

HTTP and HTTPS traffic must be allowed from.*.psionline.com since
ATLAS Cloud uses both

Downloading of .BIN and .JAR files must be permitted from both
HTTP and HTTPS addresses

http://*.psionline.com

https://*.psionline.com

For in-application testing please continue to carry out supplementary checks in Part 2
below. For anyone else, if all the steps in the checklist are followed but you cannot use
ATLAS Cloud successfully, please contact your support provider.

ATLAS Cloud System Requirements
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Supplementary Checks for In-application Testing only — Part 2

System Check

Operating system

Browser

Plugin installation

.NET Framework

Microsoft Office

Printer
configuration

Access to work-
files (Z:/)

Registry access

Demo test

For in-application testing, the following checks need to be taken in addition to those

in Part 1:

Requirements

One of the following:
Windows 7

Windows 8

Windows 10

One of the following:
Internet Explorer version 11
Google Chrome

Firefox

The PSI In-application Plugin is
required for in-application tests

.NET 3.X is required

A Microsoft Office installation is
required

Configuration changes are required
for tests to function as expected

Latest service packs are required

A default printer is required

ATLAS Cloud uses a drive-mapping
script to create a Z:/ on the machine
which is used to store test work-files

Users must have read/write access to
settings under HKEY_CURRENT_USER

A demo test should be run to confirm
successful configuration prior to
using ATLAS Cloud for live testing

ATLAS Cloud System Requirements

Implications / Things to be considered v/x

Only Microsoft Windows operating systems can run an in-
application test

(Mac users, see here)

To use our testing system with any of these browser options, a plugin
is required. For installation instructions please see Appendix F

All Supported Browsers:

Ensure the plugin is fully installed, and detected.

(instructions are listed in Appendix F)

Additional Chrome Requirements:

Ensure the extension has been installed (see here)

Additional Firefox Requirements:

Ensure the Firefox extension and the new plugin are installed (see here)

The .NET 3.X framework must be installed for tests to operate. For a
download link, please see Appendix A

For information on the versions of Microsoft Office that are supported,
see Appendix A

For instructions on configuring Office see Appendix C

For instructions on how to configure a default printer, please see
Appendix A

This script should not be blocked by any Group Policy or process

The mapped drive must be visible to candidates and no GPO should
hide either unused drives or specifically the Z:/ drive letter. If Z:/ is
already mapped on your network, the script will use the next available
letter going backwards until an available letter is found.

Test candidates must have access to this drive once created.

This access is the default configuration in Windows. If restrictions have
been introduced, they must accommodate this requirement

To access demo content, login to ATLAS Cloud, click on your name in
the top right-hand corner of the screen and click "Catalogue”.

Underneath “Demo content” you will find a series of tests that can be
used to test your ATLAS Cloud setup. Successful completion of one of
these tests will indicate appropriate configuration of the machine and
profile.
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In-application Testing Support

If all the steps in the checklist Part 1 and 2 are followed and a demo test does not run
successfully, please contact your support provider.

Test Runtime Errors

In the event of a test malfunction whilst running the test, errors will manifest themselves
as follows:

Error

A serious error has occurred. Please click the Download button to download error
information, and contact your administrator. The test will now end.

Download Close

If this message is displayed, click the download button to save a .SUPPORT file to your
desktop. Please email this file to your support provider to enable an in-depth analysis of
the problem.
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Appendix F: Plugin Guide (In-application tests only)

This appendix describes the steps required to install the PSI In-application Plugin.

The PSI In-application Plugin is intended for use with the most up to date versions of
Internet Explorer, Google Chrome, and Mozilla Firefox. Please see here for the
supported versions.

The processes for installing the PSI In-application Plugin are slightly different depending
on the browser used. For Chrome and Firefox users only, additional steps are necessary
to install a Chrome extension and Firefox extension respectively.

It is possible to install the PSI In-application Plugin, either prior to testing outside of

ATLAS Cloud®, see here, or just before a test in the System Requirements Check page for
in-application tests, see here.
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Installing the PSI In-application Plugin prior to Testing

This guide is designed for system administrators intending to prepare workstation(s) for
candidate(s). The PSI In-application Plugin MSI can be deployed to workstations in a
network using proprietary deployment software, if available, or manually to individual
machines using the following instructions.

1. Download the PSIIAPlugin.msi installation file from here. Please note, if you are
not using a *.psionline.com address then this version of the plugin may not
function correctly. If this is the case, please use the appropriate *.psionline.com
domain address.

Alternatively, you can access the plugin from the Download button on the Check
@ system requirements page or the Download link shown when running a system

requirements check (this process is covered here) as shown below

Alternative methods to access the Plugin extension prior to testing:

Download button on the Download link when running
Check System Requirements Page the system requirements page
Basic tests without in-application n Runfirg Syibem Requinernents Ched

Metwork performance

In-application tests using Office 2003

In-application tests using Office 2007

In-application tests using Office 2010

In-application tests using Office 2013

In-application tests using Office 2016

The System Requirements are also available in PDF iorn'atm

2. You will receive one or two messages to verify you wish to run the installation.
The message will ask to Run or Save the installation.
3. To run the installation straight away, click Run.

@ Please note that you can also Save the file to a chosen location on the machine
and then run the installation from there

ATLAS Cloud System Requirements Unclassified Public 31


http://international.psionline.com/downloads/PSIIAPlugin.msi

psi

Open File - Security Warning =
Do you want to run this file?

Mame: ChlsersadminDownloads\PSIAPIUgin.msi
Publisher. PSI Services LLC

Type: Windows Installer Package

From: ChilserssadmindDownloadsyPSIAPIUgin.msi

[ Fun ] I Cancel

Alwayz ask before opening thiz file

patentially harm your computer. Only run zoftware from publishers

I .ﬁl While files from the Internet can be useful, this file lype can
4 wau trust, wihat's the risk?

4. Press the Next button

j’_{;‘ PSI In-application Plugin Setup =

Waelcome to the PSI In-application Plugin
@ Satup Wizard

The Setup Wizard will install PSI In-application Plugin on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard,

Back [ Mext l I Cancel
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The installation starts and a status window is displayed.

ﬁ! PEl In-application Plugin Setup = &
Installing PSI In-application Plugin
Please wait while the Setup Wizard installs P5I In-application Flugin.
Status:
| |
Back Mext

A message may appear requiring permissions to be enabled to complete the installation.

@ Please note that this message may be hidden. If this is the case, please look on
the taskbar to access the message.

5. Press the Yes button.

@ User Account Control @

(9‘] Do you want to allow the following program to install

<" software on this computer?

@ Program name:  PSIIn-application Plugin
Verified publisher: PSI Services LLC

File crigin: Downloaded from the Internet

(%) Show details (e J[ N |

Change when these notifications appear
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A message will appear to show that the Setup Wizard is complete.

6. Click the Finish button.

j§! PSI In-application Plugin Setup = &

Completed the PSI In-application Plugin Setup
S| B

Click the Finish button to exit the Setup Wizard.

/Internet Explorer

The PSI In-application Plugin installation procedure is now complete for Internet
Explorer users.

Please note that Google Chrome and Mozilla Firefox users must continue to
@ the next sections (Installing the Google Chrome Extension prior to testing or

Installing the Mozilla Firefox Extension prior to testing), to complete the
installation process.
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Installing the Google Chrome Extension prior to testing

As well as downloading the installation file, Google Chrome users must add an

additional extension.

The method below is for installing the extension prior to testing.

@ Please ensure that the PSI In-application Plugin is installed before you add the
extension to Chrome

1. Copy and paste the following URL into the address bar:

https://chrome.google.com/webstore/search/psi%20in-

application?_category=extensions

@ Alternatively, you can access the URL from the Add to Chrome button on the
Check system requirements page or when actually running a system
requirements check (via the ATLAS Cloud login page) as shown below

Alternative methods to access the Chrome extension prior to testing:

Add to Chrome button on the Add to Chrome button when running
Check System Requirements Page the system requirements page

B Funning System Requirements Cheek

Basic tests without in-application

Network performance

n-application tests using Office 2003 m
n-application tests using Office 2007 Pogus e
A— o]
n-application tests using Office 2010
[
n-application tests using Office 2013
T F &
n-application tests using Office 2016 Hice
s are also available ‘.;U,Qm.r E
Download the PS! In-application Plugin - fap——

Install the PSI In-application Extension for Chrome EEYE RGN @ TTt TS
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The PSI In-application Extension install window will appear

2. Click on the ADD TO CHROME button

PSI In-application Extension P ——
- V
OvVERVIEW REVIEWS RELATED O
%
P32 In-apphicasion extension for
Chrome
Q

Additionad Information

1000

< pS| ) In-application Extension efemiadgalois
v I
L * Enghsh

3. Press the Add extension button

Add "PSI In-application Extension”? _
It cam: (E"_EQ
« Communicate with cooperating websites
« Communicate with cooperating native

applications

Add extension ] Cancel

Once the extension has been added to Chrome, a confirmation message will be displayed
as shown in the screenshot below:
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PSI In-application Extension has been %
added to Chrome.

(psi)

Manage your extensions by clicking Extensions in the
Teols menu.

Te get your extensions on all your computers,
sign in to Chrome.

The Chrome extension installation is now complete.

/Chrome

The PSI In-application Plugin installation procedure is now complete for Google Chrome
users

ATLAS Cloud System Requirements Unclassified Public 37



Installing the Mozilla Firefox Extension prior to testing

As well as downloading the installation file, Mozilla Firefox users must add an additional
extension.

@ Please ensure that the PSI In-application Plugin is installed before you add the
extension to Firefox.

1. From the ATLAS Cloud login page, select the Check System Requirements link

@ ATLASCloud

Login

Usemame
Passw

Gy C2017PS Erginh

ATLAS Cloud System Requirements Unclassified Public 38



psi

2. Click on the Add to Firefox button

Basic tests without InApplication
Network performance
InApplication tests using Office 2003
InApplication tests using Office 2007
inApplication tests using Office 2010
InApphcation tests using Office 2013

InApplication tests using Office 2016

The System Requirements are also available in POF format:

Download the PSI In-appkcation Piugin m

Install the PS! In-application Extension for Firefoxd

@ Alternatively, you can access the extension from the Add to Firefox button when
running a system requirements check as shown below. The full steps using this
method are covered here

Alternative method to access the Firefox extension prior to testing:

Add to Firefox button when running Check System Requirement

Running System Requirements Check

This check shows if the system requirements for the test are met. Links to mene detailed explanations will be shown if there are any errors,

Operating Systemn Windows m

Screen Resclution 1366768 [ ox |

Browser Fargfiox 51 m

Popups Enabled m Help
Tabbed Browsing [osainied m

Plisgin Mo extensaon detected m
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3. Press the Allow button

uat.psionline.com
Firefox prevented this site from asking you to install
software on your computer,

Allow -

4. Press the Install button

uat.psionline.com

This site would like to install an add-on in Firefor

P51 In-application Extension

Learn more...

Cancel Install

Once the extension has been added to Firefox, a confirmation message will be displayed,
as shown in the screenshot below:

0 uat.psionline.com

PS5l In-application Extension has been installed
successfully,

The Firefox extension installation is now complete.

/ Firefox

The PSI In-application Plugin installation procedure is now complete for Mozilla Firefox
users.
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Installing the PSI In-application Plugin at the time of Testing

This section is designed for anyone who needs to install the PSI In-application Plugin
when launching a test via the System Requirements page.

It is recommended that the In-application Plugin installation is carried out prior to any
testing. However, in some cases a System Requirements Check shows that the plugin has
not been installed, and therefore the test will not launch. If this happens, a candidate can

install the plugin themselves via the System Requirements page.

@ Please note that only in-application tests require the plugin, and therefore will
allow the plugin to be downloaded from the System Requirements Check page.

Once a test has been opened from the Catalogue page, the System Requirements Check
is carried out. If the In-application Plugin is not available an error will show in red, as seen
below.

The plugin must be downloaded to carry on with testing.

1. Click the Download link.

“ Running System Requirements Check

Lheoemg

Please note that Internet Explorer and Firefox users will not see references to
Chrome or the extension shown above. However, Firefox users will require an
extension, which is covered later in this document
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2. Once the download is complete, click the PSIIAPlugin.msi

- Running System Requirerments Chadk

Add pa
Chioms

3. Click the installation file, as highlighted above, and press the Run button

g

Open File - Secunty Warning
Do you want to run this file?

Mame: Chlserssadmin\DownloadshPSIAPIugin.msi
Publisher: PSI Services LLC

Type: Windows Installer Package
From: ChAUserssadmindDownloadsyPSIAPIugin.msi

[ Run ] [ Cancel

Always ask before opening this file

| -"\l While files from the Internet can be useful, this file wpe can
\ 6 patentially harm your computer. Only run zoftware from publishers
= wou trust, wihat's the risk?
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4. Press the Next button

ﬁ! Pl In-application Plugin Setup = 2 |

Welcome to the PSI In-application Plugin
@ Setup Wizard

The Setup Wizard will install PSI In-application Plugin on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard,

ck [ Mext ] [ Cancel

The installation will start and a status window is displayed.

j§| P&l In-application Plugin Setup = &%

Installing PSI In-application Plugin

Please wait while the Setup Wizard installs PSI In-spplication Plugin.

Status:

Back Mext Cancel

A message will appear requiring permissions to be enabled to complete the installation.
@ Please note that this message may be hidden behind the installation message. If

this is the case, it can be accessed via the Security shield icon that will appear on
the taskbar.
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5. Press the Yes button.

'5:' User Account Control @

Do you want to allow the following program to install

software on this computer?

@ Program name:  PSIIn-application Plugin
Verified publisher: PSI Services LLC

File crigin: Downloaded from the Internet

(%) Show details [ ves J[ me

Change when these notifications appear

A message will appear showing that the Setup Wizard is complete.

6. Click the Finish button

ﬁ PSI In-application Plugin Setup = X

Completed the PSI In-application Plugin Setup
S| K

Click the Finish button to exit the Setup Wizard.

(%]
)

m

Internet Explorer users can now press F5 to update the system requirements check
and show that the Plug in is installed OK
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/Internet Explorer

The PSI In-application Plugin installation procedure is now complete for Internet
Explorer users and they will see the screen below.

@ ATLASCloud

Running System Requirements Check

This check shows if the system requirements for the test are met. Links to more detailed explanations will be shown if there are any errors.

Operating System Windows 7 m
Screen Resolution 1366x768 m
Browser Chrome 51 m
Popups Enabled m
Tabbed Browsing Disabled m
Plugin 1.0.0.7 m
.NET Framework 2.0.50727.5485 32-bit m
Office Found Office 2007 (32-bit) m

Application: 1/1 Ok m

i
View Log

Launch with Java

@ Please note that Google Chrome Users must continue to the next section
Installing the Google Chrome Extension at the time of testing to complete the
installation process. Firefox users must continue to the section Installing the
Mozilla Firefox Extension at the time of testing to complete the installation
process
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Installing the Google Chrome Extension at the time of testing

As well as downloading the installation file at the time of testing, Google Chrome users
must add an additional extension.

Once the PSI In-application Plugin installation is complete, the Google Chrome user will
be taken back to the System Requirements Check page and will see that an Add to
Chrome button is available.

1. Press the Add to Chrome button

n Running System Requirerments Check

This chasch dhagas I thee Fysbem nequénements fod the 15 ste met, Links 5o mose detailed sxplanstion il be dhamn I there a0 Sy sWor

Oiperating Syslem

Srmen Rrwobulion

Tabibad Beorariineg

-
A
a4

AAd RS
Chrorms

HE T Framework

P -

A message will appear to show that you will need to access the Chrome web
store.

2. Click the OK button

uat.psionline.com says:

Installs can only be initiated by one of the Chrome Web Store item's

verified sites,
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3. Press the Install Extension link

n Running System Requirements Check

This check shows if the system requirements for the test are met. Links to more detailed explanations will be shown if there are any errors.

Operating System Windaows m
Screen Reschution 1920100 m
Browser Chrome 56 m
Popups Enabled [ ox |
Talslsedd Browsing Dhsabled m
Help
Phegin No extension detected m :’:-l:r-.lmiw:'.

Diosamiboad

The PSI In-application Extension install window will appear.

4. Click on the ADD TO CHROME button

PSI In-application Extension '

OvERvVIEwW REVIEWS RELATED O

P32 In-apphicasion extension for
Chrome

@ roport Aroe
Additional Information

\/ x Veruen 1008
ES) In-application Extension :--“:: = 2004
2 Larglage Enghsh
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1. Pressthe Add extension button

Add "PSI In-application Extension”? _
It cam: @
« Communicate with cooperating websites

« Communicate with cooperating native
applications

[ Add extension ] Cancel

After the extension has been added to Chrome, a confirmation is displayed:
PSI In-application Extension has been added to Chrome.

PSI In-application Extension has been %
added to Chrome.

(&)

Manage your extensions by clicking Extensions in the
Tools menu.

To get your extensions on all your computers,
sign in to Chrome.

5. Refresh the browser by pressing F5

@ ATLAS Cloud

Running System Requirements Check

This check shows if the system requirements for the test are met. Links to more detailed explanations will be shown if there are any errors.

Operating System Windows 7 m
Screen Resolution 1366x768 m
Browser Chrome 51 m
Popups Enabled m
Tabbed Browsing Disabled m
Plugin 1007 [ ox |
.NET Framework 2.0.50727.5485 32-bit m
Office Found Office 2007 (32-bit) m

Application: 1/1 oK m

==
/Chrome

View Log
Launch with Java

The installation procedure is now complete for Google Chrome users
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Installing the Mozilla Firefox Extension at the time of testing

As well as downloading the installation file at the time of testing, Mozilla Firefox users
must add an additional extension.

Once the PSI In-application Plugin installation is complete, the Mozilla Firefox user will be
taken back to the System Requirements Check page and will see that an Add to Firefox

button is available.

1. Press the Add to Firefox button

Running System Requirements Check

This check shows If the system requirements for the test are met. Links to more detailed sxplanations will be shown if there are any errors,

Operating Systemn Windows m

Screen Resclution 1366768 [ ox |

Erowser Farefox 51 m

Popups Enabled m Help
Tabbed Browsing [Cizaled m

Plusgin Mo extensaon detected m

2. Press the Allow button

uat.psionline.com
Firefox prevented this site from asking you to install
software on your computer,

Allow -
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3. Press the Install button

uat.psionline.com

This site would like to install an add-on in Firefox

P51 In-application Extension

Learn more...

Cancel Install

After the extension has been added to Chrome, a confirmation message is displayed:

0 uat.psionline.com

PS5l In-application Extension has been installed
successfully,

4. Refresh the browser by pressing F5

Running System Requirements Check

This check shows if the system requirements for the test are met. Links to more detailed explanations will be shown if there are any errors.

Operating System Windows
Screen Resolution 1366x768
Browser Firefox 51 0K
Popups Enabled oK

Tabbed Browsing Disabled ol

!

Plugin 1.0.0.2 0K

/ Firefox

The installation procedure is now complete for Mozilla Firefox users
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